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RX Family 

Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

Summary 

The standalone version of QE for Display [RX] (hereafter referred to as “standalone version of QE”) is a tool 
that provides a graphical interface for creating and adjusting LCD projects for CS+ or IDEs manufactured by 
third parties. This application note explains the procedures for development when using the IAR Embedded 
Workbench for Renesas RX (hereafter referred to as “EWRX”) as the IDE. 

The emWin GUI, which is based on a high-performance graphics library from SEGGER Microcontroller, can 
be used as a GUI drawing tool. The emWin library is a high-reliability embedded GUI solution which has 
been adopted in various fields. It supports all kinds of displays, achieves high performance while minimizing 
the footprint in memory, and allows embedding of the GUIs in a great variety of systems. In addition, the 
emWin provides with AppWizard, which makes it easy to configure an excellent GUI through intuitive 
operations. 

The standalone version of QE covers everything from the adjustment of the display to the creation of designs 
for screens. It can also be interlinked with various GUI development solutions to provide total support for the 
development of GUIs within short timeframes. 

This application note describes the procedures for development with the use of the standalone version of QE 
and tools with which its operation can be interlinked. 

 

Target Devices 

• RX65N and RX651 groups (ROM capacity: 1.5 to 2 Mbytes) 

• RX72N group 

• RX72M group 

• RX66N group 
 
For the procedures described in this application note, operation in one of the following environments is 
assumed. 

• Renesas Starter Kit+ for RX72N 

• RX72N Envision Kit 

• Renesas Starter Kit+ for RX65N-2MB 

• RX65N Envision Kit 
 
When you apply this application note with a different device or board, adjust the settings to be appropriate 
and thoroughly evaluate the results. 
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1. Overview 

As shown in Figure 1.1, the graphic LCD controller (hereafter referred to as “GLCDC”) has multiple blocks, 
so simply checking the display attributes requires an understanding of the GLCDC specifications and a large 
number of settings. However, the standalone version of QE makes it possible to prepare an environment in 
which the connection of the display device can be checked in a short time without needing a full 
understanding of the GLCDC specifications. The standalone version of QE is a tool that provides a graphical 
interface for display control and a facility for adjusting the timing in real-time with the display device 
connected. After timing adjustment, a header file containing the corresponding information for display control 
is output. Settings for the GLCDC are then made on the basis of this header file. 

When a serial LCD is used, follow the guide to section 4.4.1, Preparation, of Chapter 4, Procedures for 
Execution, then refer to the note for step 3.  

The AppWizard GUI drawing tool allows you to design an interactive GUI in a short time by combining 
prepared resources and settings without having to spend a long time for reading manuals or coding 
programs. In contrast, using emWin’s API programming allows the efficient implementation of a design that 
satisfies various specific requirements. 

The standalone version of QE can also be used with the Smart Configurator, which simplifies embedding of 
the Renesas drivers, and Firmware Integration Technology (FIT), which provides drivers and middleware for 
the RX family. These tools can further simplify display control and the creation and display of GUIs. 

This application note mainly concerns the use of the standalone version of QE, the Smart Configurator, and 
the following FIT modules. 

• QE for Display middleware module using Firmware Integration Technology (hereafter referred to as “QE 

Display FIT module”) 

• Graphic LCD controller module using Firmware Integration Technology (hereafter referred to as “GLCDC 

FIT module”) 

• emWin v.6.34 module using Firmware Integration Technology (hereafter referred to as “emWin FIT 

module”) 
 
The flowchart on the following page describes the basic procedure for developing systems with the use of 
the standalone version of QE. 
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Figure 1.1   Block Configuration of the GLCDC 
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1.1 Flow of System Development with the Standalone Version of QE 

Figure 1.2 shows a flow of system development with the use of the standalone version of QE. 
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Figure 1.2   System Development by Using the Standalone Version of QE 
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2. Operating Environment 

The procedures described in this application note assume operation on the Renesas Starter Kit+ for RX72N 
(hereafter referred to as “RSK RX72N”), the RX72N Envision Kit (hereafter referred to as “Envision RX72N”), 
the Renesas Starter Kit+ for RX65N-2MB (hereafter referred to as “RSK RX65N”) and the RX65N Envision 
Kit (hereafter referred to as “Envision RX65N”).  

Table 2.1 shows the operating environment for this application note. 

 

Table 2.1   Operating Environment 

Item Contents 

Integrated development 

environment (IDE) 

IAR Systems 

Embedded Workbench for Renesas RX 

Version 5.10.1 

C compiler IAR Systems 

IAR C/C++ Compiler for Renesas RX 

Version 5.10.1 

Configuration tool RX Smart Configurator Version 2.23.0 

FIT modules for the RX family • QE Display FIT module: r_qe_display_rx V1.10 

• GLCDC FIT module: r_glcdc_rx V1.60 

• emWin FIT module: r_emwin_rx V1.20 (V6.34.g.1.20) 

Toolchain IAR EWRX Toolchain 

QE Standalone version of QE for Display V3.4.0 or later 

 

Note: Download tools from the following URLs in advance. 

 

• URL for downloading the IAR Embedded Workbench for Renesas RX 

https://www.iar.com/products/architectures/renesas/iar-embedded-workbench-for-renesas-rx/ 

• URL for downloading the RX Smart Configurator 

https://www.renesas.com/en/software-tool/rx-smart-configurator 

• URL for downloading the RX driver package 

https://www.renesas.com/en/software-tool/rx-driver-package 

• URL for downloading QE for Display 

https://www.renesas.com/en/software-tool/qe-display-development-assistance-tool-display-applications 
 
  

https://www.iar.com/products/architectures/renesas/iar-embedded-workbench-for-renesas-rx/
https://www.renesas.com/en/software-tool/rx-smart-configurator
https://www.renesas.com/en/software-tool/rx-driver-package
https://www.renesas.com/en/software-tool/qe-display-development-assistance-tool-display-applications
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Table 2.2 to Table 2.5 list the conditions used in confirming operations on each of the boards. 

 

Table 2.2   Conditions for Confirming Operation (RSK RX72N) 

Item Contents 

MCU used R5F572NNDDBD (RX72N Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240 MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 240 MHz (PLL x 1/1) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or big endian 

Emulator E2 Lite 

Connection type JTAG or FINE 

Board used Renesas Starter Kit+ for RX72N 

 

Table 2.3   Conditions for Confirming Operation (Envision RX72N) 

Item Contents 

MCU used R5F572NNHDFB (RX72N Group) 

Operating frequency • Main clock: 16 MHz 

• PLL: 240 MHz (main clock x 1/1 x 15) 

• System clock (ICLK): 240 MHz (PLL x 1/1) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or big endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type FINE 

Board used RX72N Envision Kit 

(product No.: RTK5RX72N0C00000BJ) 

Board settings 

(jumper/switch) 

<SW1> 

Pin 1: don't care 

Pin 2: OFF 

 (The debugger is used.)  

<Others> 

Default settings 
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Table 2.4   Conditions for Confirming Operation (RSK RX65N) 

Item Contents 

MCU used R5F565NEDDFC (RX65N Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240 MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 120 MHz (PLL x 1/2) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or big endian 

Emulator E2 Lite 

Connection type JTAG or FINE 

Board used Renesas Starter Kit+ for RX65N-2MB 

Board settings 

(jumper/switch) 

<SW4> 

Pin 3: OFF 

Pin 4: ON 

 (The LCD is used.)  

<Others> 

Default settings 

 

Table 2.5   Conditions for Confirming Operation (Envision RX65N) 

Item Contents 

MCU used R5F565NEDDFB (RX65N Group) 

Operating frequency • Main clock: 12 MHz 

• PLL: 240 MHz (main clock x 1/1 x 20) 

• System clock (ICLK): 120 MHz (PLL x 1/2) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or big endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type JTAG 

Board used RX65N Envision Kit 

(product No.: RTK5RX65N2C00000BR) 

Board settings 

(jumper/switch) 

<SW1> 

Pin 1: ON 

Pin 2: OFF 

 (The debugger is used.)  

<SW4> 

Pin 1: OFF 

Pin 2: don't care 

 (The debugger is used.)  

<Others> 

Default settings 
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3. Related Documents 

Also refer to the following documents which are related to this application note. Please use the latest 
versions that are available. Visit the Renesas Electronics Web site to check and obtain the latest versions.  

 

Table 3.1   Documents Related to FIT Modules 

Document Title Document No. 

Firmware Integration Technology User's Manual R01AN1833 

RX Family Board Support Package Module Using Firmware Integration Technology R01AN1685 

RX Family Graphic LCD Controller Module Using Firmware Integration Technology R01AN3609 

RX Family emWin v.6.34 Module Firmware Integration Technology R01AN7047 

RX Family QE for Display Module Firmware Integration Technology R01AN7283 

• Firmware Integration Technology User's Manual 

https://www.renesas.com/en/document/apn/firmware-integration-technology-users-manual 

 

Table 3.2   Document Related to Tools 

Document Title Document No. 

RX Smart Configurator User’s Guide: IAREW R20AN0535 

• RX Smart Configurator User’s Guide: IAREW 

https://www.renesas.com/en/document/mat/rx-smart-configurator-users-guide-iarew 

 

Table 3.3   Documents Related to Boards 

Document Title Document No. 

RX65N Group Renesas Starter Kit+ for RX65N-2MB User’s Manual R20UT3888 

RX65N Group RX65N Envision Kit User's Manual R01UH0761 

RX72N Group Renesas Starter Kit+ for RX72N User’s Manual R20UT4443 

RX72N Group RX72N Envision Kit User's Manual R20UT4788 

• RX65N Group Renesas Starter Kit+ for RX65N-2MB User’s Manual 

https://www.renesas.com/en/document/mat/renesas-starter-kit-rx65n-2mb-users-manual 

• RX65N Group RX65N Envision Kit User’s Manual 

https://www.renesas.com/en/document/mat/rx65n-envision-kit-users-manual 

• RX72N Group Renesas Starter Kit+ for RX72N User’s Manual 

https://www.renesas.com/en/document/mat/renesas-starter-kit-rx72n-users-manual-rev100 

• RX72N Group RX72N Envision Kit User's Manual 

https://www.renesas.com/en/document/mat/rx72n-envision-kit-users-manuals-rev101 

 

Table 3.4   Documents Related to Devices 

Document Title Document No. 

RX65N Group, RX651 Group User's Manual: Hardware R01UH0590 

RX72N Group User’s Manual: Hardware R01UH0824 

• RX65N Group, RX651 Group User's Manual: Hardware 

https://www.renesas.com/en/document/mah/rx65n-group-rx651-group-users-manual-hardware 

• RX72N Group User's Manual: Hardware 

https://www.renesas.com/en/document/mah/rx72n-group-users-manual-hardware 

 

 

  

https://www.renesas.com/en/document/apn/firmware-integration-technology-users-manual
https://www.renesas.com/en/document/mat/rx-smart-configurator-users-guide-iarew
https://www.renesas.com/en/document/mat/renesas-starter-kit-rx65n-2mb-users-manual
https://www.renesas.com/en/document/mat/rx65n-envision-kit-users-manual
https://www.renesas.com/en/document/mat/renesas-starter-kit-rx72n-users-manual-rev100
https://www.renesas.com/en/document/mat/rx72n-envision-kit-users-manuals-rev101
https://www.renesas.com/en/document/mah/rx65n-group-rx651-group-users-manual-hardware
https://www.renesas.com/en/document/mah/rx72n-group-users-manual-hardware
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4. Procedures for Execution 

This chapter describes the procedures for creating a new project for the EWRX by using the RX Smart 
Configurator and for displaying a GUI design on the display and adjusting it in real-time by using the 
standalone version of QE. 

The GLCDC or emWin (GUI drawing tool) is provided in the FIT format. These can be embedded in projects 
by using the Smart Configurator. Settings for the GLCDC or emWin can be made in the GUI of the 
standalone version of QE. You can easily proceed with GUI development by following the workflow of the 
standalone version of QE. 

Before starting this project, be sure to make the jumper settings stated in chapter 2, Operating Environment, 
if this is required. 

For the usage of the standalone version of QE, refer to chapter 6, Using the Standalone Version of QE. 

 

Preparation 

1. Installing the standalone version of QE 
 
Procedure 

2. Creating a new project 

3. Making the clock settings 

4. Making the initial settings according to the workflow of the standalone version of QE 

5. Building the project 

6. Connecting a debugger and executing the program 

7. Adjusting the display in real-time by following the workflow of the standalone version of QE 
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4.1 Installing the Standalone Version of QE 

Install the standalone version of QE. Use the following procedure to install this product. 

Download QE from the following URL and perform installation. 

• QE for Display: Development Assistance Tool for Display Applications 

https://www.renesas.com/qe-display#downloads 

A QE for Display package of V3.4.0 or later 
 
Note that the procedure for updating is the same as that for installation. 

Method for Installation: 

1. Unzip the zip file at a desired location on your PC. 

Note: Do not place it under the OS program folder (C:¥Program Files). 

2. Double-click on “¥QE-Display¥eclipse¥qe-display.exe” to start the standalone version of QE. 

3. The license agreement dialog box is displayed when you start the standalone version of QE for the first 

time. Confirm the contents of the license agreement and select “Agree” or “Disagree”. 
 

 

 

4. If you select “Agree” in the above step, the standalone version of QE will be launched and ready to use. If 

you select “Disagree”, the standalone version of QE will not start. 
 
To uninstall the standalone version of QE, follow the procedure below. 

Method for Uninstallation: 

Simply delete the folder where you unzipped the zip file. 

  

https://www.renesas.com/qe-display#downloads
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4.2 Creating a New Project 

Launch the Smart Configurator. 

1. Click on “File” -> “New”. 
 

 

 

2. Make the Smart Configurator settings. 

⎯ Select the platform (board to be used) and toolchain. 

⎯ Enter the configuration file name.  

(An EWRX project file with the same name is generated.) 

⎯ Specify the folder for saving the file. 

When all settings are completed, click on the “Finish” button. 

If the board to be used is not among the available selections, click on “Download more boards” to 

download the board description file (BDF) of the board to be used before making the settings. 
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A new project is created in the specified folder for saving the file. 
 

 

 

3. Start the EWRX. 

Double-clicking on the .eww file starts the EWRX and opens a dialog box like that shown below. Select 

“Yes” to convert the format of the project file. A workspace for the created project is opened. 
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4.3 Making the Clock Settings 

Make clock settings to suit the board to be used. 

1. Select the “Clocks” tab of the Smart Configurator. 

2. Set the clock to be suitable for the board to be used. The signal at the PLL operating frequency is the 

clock source for the LCD panel. Here, suppose that the main clock is to be the clock source and set 

“Frequency Division” and “Frequency Multiplication” for the PLL circuit so that the PLL operating 

frequency will be 240 MHz. 

3. Click on the “Generate Code” button. 
 
Table 4.1   Setting Clocks 

Evaluation Board Frequency of 

the Main Clock 

PLL Operating 

Frequency 

Division and Multiplication to Obtain the 

PLL Frequency from the Main Clock 

RSK RX72N 24 MHz 240 MHz 1/1 x 10 

Envision RX72N 16 MHz 240 MHz 1/1 x 15 

RSK RX65N 24 MHz 240 MHz 1/1 x 10 

Envision RX65N 12 MHz 240 MHz 1/1 x 20 
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4.4 Making Settings According to the Workflow of the Standalone Version of QE 

Double-click on “¥QE-Display¥eclipse¥qe-display.exe” to start the standalone version of QE. 

Set the LCD in the order of “1. Preparation” and “2. LCD Adjustment” in the “LCD Workflow (QE)” view. 

 

 

Note: In an environment where the WebView2 runtime is not installed in your PC, the workflow cannot be 

displayed. In this case, download and install WebView2 (x64 version) from the Microsoft web page. 

• Renesas Customer Hub FAQ 3000670: 

https://en-support.renesas.com/knowledgeBase/20814216 
 

  

https://en-support.renesas.com/knowledgeBase/20814216
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4.4.1 Preparation 

Make the settings for “1. Preparation” in the workflow view of the standalone version of QE. 

1. “Selecting a project” 

Select the project that was created. The path to the folder for the file that was generated by the Smart 

Configurator will automatically be entered. Confirm that the entered location is correct. 
 

 

 

2. “Selecting a device” 

⎯ Select the target board to be used. 

⎯ If you are not using an evaluation board manufactured by Renesas, select “Custom” and manually 

specify the target microcontroller. 

⎯ If you are using an evaluation board manufactured by Renesas, the microcontroller will automatically 

be selected. 
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3. When “Custom” is selected in “Selecting a device”, select the LCD information to be used in “Selecting a 

LCD”. When an evaluation board manufactured by Renesas is selected in “Selecting a device”, the LCD 

information is fixed. 
 

 

 

Note: When using a serially connected LCD, select “Use serial connection (emWin)” for “Selecting a 

connection type”. The steps after that are the same as those for the plug-in version of QE for 

Display. Refer to the application note for the plug-in version. 

• RX Family 

QE for Display GUI Display Application Development Guide using Serial Connection LCD 

https://www.renesas.com/en/document/apn/rx-family-qe-display-gui-display-application-

development-guide-using-serial-connection-lcd 

However, the following steps have to be added when building a project. 

1. Add the following files to the workspace of the project as the target files for building. Also, 

add the paths to these files to “Project” -> “Options” -> “C/C++ Compiler” -> “Preprocessor” -

> “Additional include directories” of the EWRX. The files under aw¥Simulation will not be 

added. 

⎯ qe_emwin_config.h 

⎯ Files under aw¥Resource 

⎯ Files under aw¥Source 

2. Add the following definition to “Project” -> “Options” -> “C/C++ Compiler” -> “Preprocessor” -

> “Defined symbols” of the EWRX. 

⎯ QE_EMWIN_CONFIGURATION 
 
  

https://www.renesas.com/en/document/apn/rx-family-qe-display-gui-display-application-development-guide-using-serial-connection-lcd
https://www.renesas.com/en/document/apn/rx-family-qe-display-gui-display-application-development-guide-using-serial-connection-lcd
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4. Select the drawing tool to be used in “Selecting the GUI drawing tool”. 

When only adjustment by the LCD controller (GLCDC) is to be performed without creating a GUI, select 

“Not Use” and proceed to section 4.4.2, Adjusting the LCD (without the Drawing Tool). 

When a GUI is to be created, select “Use emWin” and proceed to section 4.4.3, Adjusting the LCD (with 

Use of the Drawing Tool).  

Note: The Aeropoint GUI does not support the IAR C/C++ Compiler for Renesas RX. 
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4.4.2 Adjusting the LCD (without the Drawing Tool) 

Adjust the LCD without creating a GUI by using the drawing tool. 

1. Installation status of the LCD controller 

⎯ Select “Installing the LCD controller” in the “LCD Workflow (QE)” view. 

⎯ If the GLCDC or QE Display FIT module is not installed, the following error message will be displayed. 
 

 

 

  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 20 of 96 

Apr.15.25  

2. Install the GLCDC and QE Display FIT modules. 

⎯ Open the “Components” tab of the Smart Configurator and click on the “Add component” icon. 

⎯ In the “New Component” dialog box that is displayed, select the following components and click on the 

“Finish” button. 

• “Graphics LCD Controller Module. (r_glcdc_rx)” (version 1.60 or a later version) 

• “QE for Display middleware module (r_qe_display_rx)” (version 1.10 or a later version) 
 

 

 

3. If the GLCDC and QE Display FIT modules are not displayed in the list of components in the “New 

Component” dialog box, click on “Download the latest FIT drivers and middleware”. 
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4. In the “FIT Module Download” dialog box, remove the check against “Show RX Driver Package only”, 

select the FIT modules corresponding to the components that were not displayed, and click on 

“Download”. 

The correspondence between the components and FIT modules are as follows: 

⎯ “Graphics LCD Controller Module. (r_glcdc_rx)” 

“RX Family Graphic LCD Controller Module” (Rev. 1.60 or a later revision) 

⎯ “QE for Display middleware module (r_qe_display_rx)” 

“RX Family QE for Display Module” (Rev. 1.10 or a later revision) 
 

 

 

5. Read the description in the “End User License Agreement (Sample Code)” dialog box. If you agree, click 

on “Accept”. 
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6. Since the list of components will be updated, add the required components and click on the “Finish” 

button. 
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7. Components having dependencies with the added components are automatically added. However, a 

component that has not been added or a component with a version that differs from the required one will 

lead to an error message or a warning. 

In such cases, add the required component or update the version. 

The following shows an error message for the “r_sci_rx” and “r_gpio_rx” components that have not been 

added and a warning message regarding the version of the “r_cmt_rx” component. 
 

 

 

  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 24 of 96 

Apr.15.25  

8. Add the “r_sci_rx” and “r_gpio_rx” components that are missing. 

⎯ Click on the “Add component” icon. 

⎯ In the “New Component” dialog box that is displayed, select the following components and click on the 

“Finish” button. 

• “SCI Driver” (r_sci_rx) 

• “GPIO Driver” (r_gpio_rx) 

If the components have not been added to the list of components, click on “Download the latest FIT 

drivers and middleware” and download the components from the list of available components. Since, 

depending on the component, it may be included in “RX Driver Package”, download the latest version of 

“RX Driver Package”. 

Note that a component may not be displayed if the checkbox for “Hide items that have duplicated 

functionality” is selected. 
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Update “r_cmt_rx” to the required version. 

9. Right-click on the “r_cmt_rx” component and select “Change version”. 
 

 

 

10. Confirm “Available versions” in the “Change Version” dialog box and click on the “Next” button. 

11. Confirm the changes in the settings and click on the “Finish” button. 
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12. When the confirmation message is displayed in the “Change Version” dialog box, click on “Yes”. 
 

 

 

13. When the confirmation message is displayed in the “Code Generating” dialog box, click on “Proceed”. 
 

 

 

14. The error and warning regarding the dependencies of components have now been resolved. 
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15. If you have selected a board when creating the project, pins for use by the GLCDC are also set in 

response to adding the component for the GLCDC. You can confirm the settings of pins by selecting 

“Graphic-LCD controller” on the “Pins” tabbed page. If you are using a custom board, make the settings 

of pins on this tabbed page. 
 

 

 

16. Additionally set the components and SCI pins to suit the board to be used. (Table 4.2 to Table 4.5) 
 
Table 4.2   Settings when the RSK RX72N is to be Used 

Component or SCI Pin Item Value 

r_qe_display_rx UART channel UART9 

r_sci_rx Include software support for channel 9 Include 

SCI9 Checked 

RXD9/SMISO9/SSCL9 Pin Used 

TXD9/SMOSI9/SSDA9 Pin Used 

SCI9 pin RXD9 Pin Number J10 

TXD9 Pin Number P12 

 

Table 4.3   Settings when the Envision RX72N is to be Used 

Component or SCI Pin Item Value 

r_qe_display_rx UART channel UART2 

r_sci_rx Include software support for channel 2 Include 

SCI2 Checked 

RXD2/SMISO2/SSCL2 Pin Used 

TXD2/SMOSI2/SSDA2 Pin Used 

SCI2 pin RXD2 Pin Number 45 

TXD2 Pin Number 44 
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Table 4.4   Settings when the RSK RX65N is to be Used 

Component or SCI Pin Item Value 

r_qe_display_rx UART channel UART8 

r_sci_rx Include software support for channel 8 Include 

SCI8 Checked 

RXD8/SMISO8/SSCL8 Pin Used 

TXD8/SMOSI8/SSDA8 Pin Used 

SCI8 pin RXD8 Pin Number 59 

TXD8 Pin Number 58 

 

Table 4.5   Settings when the Envision RX65N is to be Used 

Component or SCI Pin Item Value 

r_qe_display_rx UART channel UART5 

r_sci_rx Include software support for channel 5 Include 

SCI5 Checked 

RXD5/SMISO5/SSCL5 Pin Used 

TXD5/SMOSI5/SSDA5 Pin Used 

SCI5 pin RXD5 Pin Number 70 

TXD5 Pin Number 67 

 
  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 29 of 96 

Apr.15.25  

17. Click on the “Generate Code” button  in the upper-right corner of the Smart Configurator window. The 

code is generated according to the settings. 

After code generation has finished, the state indicators for the GLCDC and QE Display FIT modules are 

changed to “Added”. 
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18. Select “LCD display adjustment” in the “LCD Workflow (QE)” view. 

Adjust the LCD. 

Clicking on the “TCON/LCD setting”, “Timing adjustment”, “Graphic layer setting”, and “Image quality 

adjustment” buttons opens the “Display Tuning RX (QE)” views of the standalone version of QE which 

correspond to each button and allows changing of the settings. When an evaluation board is in use, 

settings do not have to be made because the default settings will be reflected. 

In addition, clicking on the “Start Display Adjustment” button in each “Display Tuning RX (QE)” view 

allows adjustment of the display with real-time confirmation on the actual display. 

For details, refer to the help system entries for the “Display Tuning RX (QE)” views. 
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19. In the standalone version of QE, a value has to be entered in “PLL Circuit Frequency [MHz]” on the 

“Timing Adjustment” tabbed page, according to the setting on the “Clocks” tabbed page of the Smart 

Configurator. Also, select the value of “Panel Clock Frequency [MHz]” following the prompt. 
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The following values are automatically set when the panel clock frequency is 10 MHz in the RSK RX72N, 
RSK RX65N, Envision RX72N, or Envision RX65N. 

Table 4.6   Example of Timing Settings when the Panel Clock Frequency is 10 MHz (for RSK RX72N 

and RSK RX65N) 

Connected Device Item Value 

NHD-4.3-480272EF-ATXL#-CTP VPW 10 

VBP 2 

VDP 272 

VFP 2 

VTP 286 

HPW 41 

HBP 29 

HDP 480 

HFP 34 

HTP 584 

 

Table 4.7   Example of Timing Settings when the Panel Clock Frequency is 10 MHz (for Envision 

RX72N and Envision RX65N) 

Connected Device Item Value 

ER-TFT043-3 VPW 1 

VBP 7 

VDP 272 

VFP 8 

VTP 288 

HPW 14 

HBP 75 

HDP 480 

HFP 15 

HTP 584 

 
If you are using a custom board, set the values on the “Timing Adjustment” tabbed page such that no errors 
appear in the display. 

Here, modify the values so that values for the horizontal frequency that are in error produce normal results 
after having modifying the value for the panel clock frequency. 
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20. Click on “Timing adjustment”. 

21. The “Display Tuning RX (QE)” view of the standalone version of QE opens. If a value has an error, an 

error mark  is displayed. Modify the value so this error mark disappears. 
 

 

 

22. Adjust the value of “Panel Clock Frequency [MHz]”, which is displayed in red to indicate that it is in error. 

Here, select “10.000000”, which is the nearest available value to the 9.0 MHz panel clock frequency for 

the LCD, from the combo box. 
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23. Setting the value of the panel clock frequency to 10.0 MHz makes the value of “Horizontal Frequency 

[kHz]” incorrect, so it is displayed in red. 

Hovering the mouse cursor over the erroneous value (the value of “Horizontal Frequency [kHz]”) 

displayed in red produces a display of the range of specifiable values. 

Hovering the mouse cursor over the label (“Horizontal Frequency [kHz]”) for the erroneous value 

produces a display of a description of how to eliminate the error. 
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24. Clicking on the “Auto Adjustment” button to the right of “Panel Clock Frequency [MHz]” automatically sets 

each value so that the refresh rate and the horizontal frequency are within the range of specifiable 

values at the specified panel clock frequency. Once there are no errors, the “Auto Adjustment” button 

becomes inactive. 
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The settings of the LCD can be adjusted by the GUIs for the display adjustment facilities while confirming the 
results on the actual display. The following shows an example of the adjustment of brightness from the 
“Image Quality Adjustment” tabbed page. 

25. Click on the “Start Display Adjustment” button to open the “Connection setting” dialog box. 

26. Click on the “Generate GLCDC Parameter File” button to output the settings that have been made so far. 
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27. Click on the “Show Sample Code” button and implement the programs used to display the window for 

adjusting the LCD in the main() function. 
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28. Add the following files to the workspace of the project as the target files for building. Also, add the paths 

to these files to “Project” -> “Options” -> “C/C++ Compiler” -> “Preprocessor” -> “Additional include 

directories” of the EWRX. 

⎯ r_lcd_timing.h 

⎯ r_image_config.h 

29. Add the following definition to “Project” -> “Options” -> “C/C++ Compiler” -> “Preprocessor” -> “Defined 

symbols” of the EWRX. 

⎯ QE_DISPLAY_CONFIGURATION 
 

 

 

30. Build a project with reference to section 4.5, Building the Project. 

31. Make the settings for the debugger and execute the project with reference to section 4.6, Connecting a 

Debugger and Executing the Program. A demonstration image is displayed on the display. 
 

  Demonstration image 
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32. Make the following settings in the “Connection setting” dialog box and click on “Start adjustment”. 

⎯ Baud rate: 115200 

⎯ COM port: Auto 
 

 

 

33. When the board is connected to the device and adjustment of the display is started, the “Start Display 

Adjustment” button is replaced by the “Finish Display Adjustment” button.  
 

 

  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 40 of 96 

Apr.15.25  

34. Select the “Image Quality Adjustment” tabbed page in the “Display Tuning RX (QE)” view, then select 

“Brightness” from the menu to the left. 
 

 

 

35. Modify the value for the gauge of “Quick Setting” or the values of “Custom” and click on the “Set the 

Register” icon ( ). 

The values are set in the registers and can be confirmed on the display of the connected board. 

Repeat modification of the values and settings of the registers until the display is as expected. 
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36. After you have finished adjusting the values, click on the “Finish Display Adjustment” button. 
 

 

 

37. The board is disconnected from the device and the “Start Display Adjustment” button is restored to 

replace the “Finish Display Adjustment” button. 

The message “Tuning finished.” appears in the console of QE for Display. 
 

 

 

38. Header files reflecting the results of adjusting the display are then output. 

Click on the “Generate file” button to output r_image_config.h and r_lcd_timing.h. They are output to src 

immediately under the project folder by default. The output destination folder can be changed by selecting 

the “Select folder” checkbox. 
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4.4.3 Adjusting the LCD (with Use of the Drawing Tool) 

Create a GUI by using the drawing tool and use it to adjust the LCD. 

1. Installation status of the LCD controller 

⎯ Select “Installing the LCD controller” in the “LCD Workflow (QE)” view. 

⎯ If the GLCDC or QE Display FIT module is not installed, the following error message will be displayed. 
 

 

 

2. Install the GLCDC and QE Display FIT modules by using the Smart Configurator. 

For the installation procedure, refer to steps 2 to 17 in section 4.4.2, Adjusting the LCD (without the 

Drawing Tool).  

Note: If you are only creating and displaying a GUI without adjusting the display, you need not install the 

QE Display FIT module. 
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The GLCDC and QE Display FIT modules are installed (only the GLCDC FIT module is installed when the 
display is not to be adjusted).  

3. Installation status of the GUI drawing tool 

⎯ Select “Installing the GUI drawing tool driver” in the “LCD Workflow (QE)” view. 

⎯ If the drawing tool is not installed, the following error message will be displayed. 
 

  

 

4. Select the “Components” tab of the Smart Configurator and click on the “Add component” icon. 

5. In the “New Component” dialog box, select “Graphic Library with Graphical User Interface (r_emwin_rx)” 

(version 6.34.g.1.20 or a later version) and click on the “Finish” button. 
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6. If the drawing tool is not displayed in the list of components in the “New Component” dialog box, click on 

“Download the latest FIT drivers and middleware” and download the latest version of “RX Driver 

Package”. 
 

 

 

7. When “Graphic Library with Graphical User Interface (r_emwin_rx)” is displayed in the list of components, 

select it and click on the “Finish” button. 
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8. When the “r_emwin_rx” component is added, an error occurs in the heap size used by the drawing tool. 

Since the heap size must be at least 0x4000, enter the value 0x4000 here. 
 

 

 

9. Make the following settings for the “r_emwin_rx” component. 
 
Table 4.8   Settings of the “r_emwin_rx” Component 

Item Value 

LCD_Interface LCD_IF_GLCDC 

Use Touch function Checked 

Touch interface TOUCH_IF_SCI_IIC 
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10. Additionally set the components and SCI pins to suit the board to be used. The IIC is used by touch 

facilities of emWin (see step 9). (Table 4.9 to Table 4.12) 
 
Table 4.9   Settings when the RSK RX72N is to be Used 

Component or SCI Pin Item Value 

r_sci_iic_rx MCU supported channels for CH11 Supported 

SCI11 Checked 

SSCL11 Pin Checked 

SSDA11 Pin Checked 

SCI11 pin SSCL11 Pin Number E8 

SSDA11 Pin Number G8 

 

Table 4.10   Settings when the Envision RX72N is to be Used 

Component or SCI Pin Item Value 

r_sci_iic_rx MCU supported channels for CH6 Supported 

SCI6 Checked 

SSCL6 Pin Checked 

SSDA6 Pin Checked 

SCI6 pin SSCL6 Pin Number 26 

SSDA6 Pin Number 27 

 

Table 4.11   Settings when the RSK RX65N is to be Used 

Component or SCI Pin Item Value 

r_sci_iic_rx MCU supported channels for CH7 Supported 

SCI7 Checked 

SSCL7 Pin Checked 

SSDA7 Pin Checked 

SCI7 pin SSCL7 Pin Number 160 

SSDA7 Pin Number 163 

 

Table 4.12   Settings when the Envision RX65N is to be Used 

Component or SCI Pin Item Value 

r_sci_iic_rx MCU supported channels for CH6 Supported 

SCI6 Checked 

SSCL6 Pin Checked 

SSDA6 Pin Checked 

SCI6 pin SSCL6 Pin Number 7 

SSDA6 Pin Number 8 
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11. When a board is selected in the creation of a project, setting the IIC channel to be used with emWin also 

sets the pins for use with the channel. Select “Serial communications interface” on the “Pins” tabbed 

page to confirm the settings of the pins. Set the pins here if you are using a custom board. 
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12. Click on the “Generate Code” button  in the upper-right corner of the Smart Configurator window. The 

code is generated according to the settings. 

13. In the “Code Generating” dialog box, set the data endian and click on the “OK” button.  

The code is generated according to the settings. 

After code generation has finished, the state indicator for the drawing tool is changed to “Added”. 
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14. Select “Setting of GUI drawing tool” in the “LCD Workflow (QE)” view. 

15. Select “Info setting” and make the settings for the drawing tool in the dialog box that is displayed. 

When an evaluation board is used, settings do not have to be made because the default settings will be 

reflected. 
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16. After completing making the settings, click on the “Generate file” button to output qe_emwin_config.h. 

It is output to src immediately under the project folder by default. The output destination folder can be 

changed by selecting the “Select folder” checkbox. 
 

 

 

17. Select “Generate GUI” in the “LCD Workflow (QE)” view. 

18. After clicking on “Installation of GUI drawing tools”, click on the “Installing AppWizard” button to install 

AppWizard by following the instructions of the AppWizard setup wizard that is displayed. 
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19. After having installed AppWizard, the state indicator of the “AppWizard settings” dialog box is changed to 

“AppWizard is installed”. Click on the “OK” button to close the “AppWizard settings” dialog box. 
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20. Select “Start GUI drawing tool” to start AppWizard. 
 

 

 

Note: The usage of AppWizard may differ from the way which is described in this application note due to 

changes to the specifications. For the usage of AppWizard, refer to its help system. 
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21. When AppWizard is started, the “aw” project folder of AppWizard is automatically created immediately 

under the project. This folder contains Resource, Simulation, and Source folders and the project file for 

AppWizard (aw.AppWizard). 
 

 

 

22. In the AppWizard project, the board to be used, display size, and color depth per pixel have automatically 

been specified. 

The setting values can be confirmed in the “Edit project properties” dialog box which is opened from the 

“Edit Options” item of the “Project” menu. 
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23. Create a GUI with AppWizard. 

Start by adding a screen. Clicking on the “Screen” button adds the screen of “ID_SCREEN_00”. Multiple 

screens can be set and this allows switching between their displays. 
 

 

 

24. After that, add an image. Clicking on the “Image” button adds the image of “ID_IMAGE_00”. The position 

and size are adjusted in “Editor” or “Properties”. In this case, use “Editor” to expand the image to fill the 

LCD screen. 
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25. To change the image, click on “Set bitmap” in “Properties” and click on the rectangle below the label. 

Select a desired image from “Select image for mode <>” and click on “Select”.  
 

 

 

26. Add a button. Clicking on the “Button” button adds the button of “ID_BUTTON_00”. The position and size 

are adjusted in “Editor” or “Properties”. 
 

 

 

  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 57 of 96 

Apr.15.25  

27. To change images to indicate when the button is and is not being pressed, in the same manner as when 

changing the image, click on the button image in “Set bitmaps” of “Properties”. 
 

 

 

28. The button image is changed.  
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29. Clicking on the “Start play mode” button located at the upper right in “Editor” confirms the operation of the 

created GUI in the preview. By clicking on the button in the preview, you can confirm that the image 

changes according to the settings made for “Unpressed” and “Pressed”. Clicking on the “Esc” button 

closes the preview. 
 

 

 

30. Output code from AppWizard. 

Select the “Export & Save” item from the “File” menu of AppWizard. 

Code is output in the “Source” and “Resource” folders under the “aw” project folder of AppWizard. 
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31. Select “LCD display adjustment” in the “LCD Workflow (QE)” view. 

Adjust the LCD. 

For the adjustment procedure, refer to steps 18 to 26 in section 4.4.2, Adjusting the LCD (without the 

Drawing Tool). 

If you are not going to adjust the LCD, just click on “Generate file”. 
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32. Click on the “Show Sample Code” button and implement the programs used to display the GUI that was 

created with AppWizard in the main() function. 

 

⎯ When adjusting the display 
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⎯ When not adjusting the display 

The “Show Sample Code” button in the figure below is disabled when the QE Display FIT module has 

been installed in step 2. 
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33. Add the following files to the workspace of the project as the target files for building. Also, add the paths 

to these files to “Project” -> “Options” -> “C/C++ Compiler” -> “Preprocessor” -> “Additional include 

directories” of the EWRX. The files under aw¥Simulation will not be added. 

⎯ r_lcd_timing.h 

⎯ r_image_config.h 

⎯ qe_emwin_config.h 

⎯ Files under aw¥Resource 

⎯ Files under aw¥Source 

34. Add the following definitions to “Project” -> “Options” -> “C/C++ Compiler” -> “Preprocessor” -> “Defined 

symbols” of the EWRX. 

⎯ QE_DISPLAY_CONFIGURATION 

⎯ QE_EMWIN_CONFIGURATION 
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35. Change the value of “Project” -> “Options” -> “General Options” -> “Stack/Heap” -> “Heap size” of the 

EWRX to the value set for “Heap size” of the “r_bsp” component in the Smart Configurator. 
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36. When “Used” is set for DRW2D in “Info setting” in “Setting of GUI drawing tool” in the “LCD Workflow 

(QE)” view (step 15), the image data has to be located to an address aligned with a 4-byte boundary. 

Specify the alignment of the image data with reference to the following FAQ. 

⎯ Renesas Customer Hub FAQ 2001488: 

https://en-support.renesas.com/knowledgeBase/20940283 

 

37. Build a project with reference to section 4.5, Building the Project. 

38. Make the settings for the debugger and execute the project with reference to section 4.6, Connecting a 

Debugger and Executing the Program. The screen that was created with the GUI drawing tool is 

displayed on the panel. Touch the button and confirm that the image changes according to your settings. 
 

 

 

39. When the QE Display FIT module has been installed, the LCD can be adjusted in real-time while the 

created screen continues to be displayed. 

For the adjustment procedure, refer to steps 32 to 38 in section 4.4.2, Adjusting the LCD (without the 

Drawing Tool). 
 

  

https://en-support.renesas.com/knowledgeBase/20940283
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4.5 Building the Project 

 
Build the project and create debugger session according to the following procedure. 

 

1. Click on “Project” -> “Rebuild All”. 
 

 

 

2. When “Build succeeded” is displayed in the “Build” panel, the build operation is complete. 
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4.6 Connecting a Debugger and Executing the Program 

1. Click on “Project” -> “Options” of the EWRX. 

2. Select “Debugger” in the “Options” dialog box, set the debugger (example: E2 Lite) to be used in “Driver”, 

and click on “OK”. 
 

 

 

3. Since “E2/E2 Lite” will be added as a menu, click on the “Hardware Setup” item of the “E2/E2 Lite” menu. 
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4. Select the “MCU” tab in the “Hardware Setup” dialog box. 

5. Change the settings and values for “EXTAL frequency”, “ICLK frequency”, and “Communication” to suit 

the board. For setting the board, refer to chapter 2, Operating Environment. 

6. Change the setting and value for “Power target from the emulator (MAX 200mA)” to suit the board. 
 
Table 4.13   Power Supplied from the Emulator 

Evaluation Board Power Supplied from the Emulator 

RSK RX72N 

RSK RX65N 

No 

Envision RX72N 

Envision RX65N 

No 

 

Note: To supply power to the RSK RX72N and RSK RX65N, use an external power source having a stable 

DC output (min. 10 W) and center-positive connector. 

 

7. When the settings have been made, click on “OK”. 
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8. Click on “Download and Debug” on the toolbar.  

9. The program is executed and breaks at the beginning of the main function. Click on “Go” on the toolbar. 
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5. Hardware 

5.1 Configuration of Hardware 

Table 5.1 shows the LCD panel used in this application note. 

 

Table 5.1   LCD Panel Used in the Sample 

Board Information on the LCD Panel Product 

RSK RX72N 

RSK RX65N 

Manufacturer: Newhaven Display Co. 

Part number: NHD-4.3-480272EF-ATXL#-CTP 

Display size:480 x 272 

Synchronization signal: VS, HS, DE (three signals) 

Built-in touch controller 

Envision RX72N 

Envision RX65N 

Manufacturer: EastRising Co. 

Part number: ER-TFT043-3 

Display size:480 x 272 

Synchronization signal: VS, HS, DE (three signals) 

Built-in touch controller 

 

5.2 Pin Functions 

The following shows pins used on each RSK and Envision and describes the pin functions used. Select the 
pins according to the product you are using. Pin functions are automatically set by using the Smart 
Configurator and the standalone version of QE. 
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Table 5.2   Pins and Functions to be Used (RSK RX72N) 

Connected 

Device 

Pin Name Input/Output Description 

NHD-4.3-
480272EF-
ATXL#-CTP 

P14/LCD_CLK-B Output Outputs the panel clock. 

P13/LCD_TCON 0-B Output Outputs the synchronization signal (VSYNC). 

PJ2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PC5/LCD_DATA 0-B Output Outputs the LCD signal R[3]. 

P82/LCD_DATA 1-B Output Outputs the LCD signal R[4]. 

P81/LCD_DATA 2-B Output Outputs the LCD signal R[5]. 

P80/LCD_DATA 3-B Output Outputs the LCD signal R[6]. 

PC4/LCD_DATA 4-B Output Outputs the LCD signal R[7]. 

P55/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

P54/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

P11/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

P83/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PC7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PC6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PJ0/LCD_DATA 11-B Output Outputs the LCD signal B[3]. 

P85/LCD_DATA 12-B Output Outputs the LCD signal B[4]. 

P84/LCD_DATA 13-B Output Outputs the LCD signal B[5]. 

P57/LCD_DATA 14-B Output Outputs the LCD signal B[6]. 

P56/LCD_DATA 15-B Output Outputs the LCD signal B[7]. 

PQ1/SSCL11 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

PQ2/SSDA11 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

P27/general-purpose 
input/output port 

Output Backlight 

PK4/general-purpose 
input/output port 

Output Panel reset 

PL3/general-purpose 
input/output port* 

Output Touch controller reset 

Note: When PL3 is to be used, a resistor must be changed. For details, refer to the user’s manual of the 

evaluation board. 

 
  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 71 of 96 

Apr.15.25  

Table 5.3   Pins and Functions to be Used (Envision RX72N) 

Connected 

Device 

Pin Name Input/Output Description 

ER-TFT043-3 PB5/LCD_CLK-B Output Outputs the panel clock. 

PB4/LCD_TCON 0-B Output Outputs the synchronization signal 
(VSYNC). 

PB2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PB0/LCD_DATA 0-B Output Outputs the LCD signal B[3]. 

PA7/LCD_DATA 1-B Output Outputs the LCD signal B[4]. 

PA6/LCD_DATA 2-B Output Outputs the LCD signal B[5]. 

PA5/LCD_DATA 3-B Output Outputs the LCD signal B[6]. 

PA4/LCD_DATA 4-B Output Outputs the LCD signal B[7]. 

PA3/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

PA2/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

PA1/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

PA0/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PE7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PE6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PE5/LCD_DATA 11-B Output Outputs the LCD signal R[3]. 

PE4/LCD_DATA 12-B Output Outputs the LCD signal R[4]. 

PE3/LCD_DATA 13-B Output Outputs the LCD signal R[5]. 

PE2/LCD_DATA 14-B Output Outputs the LCD signal R[6]. 

PE1/LCD_DATA 15-B Output Outputs the LCD signal R[7]. 

P33/SSCL6 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

P32/SSDA6 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

P67/general-purpose 
input/output port 

Output Backlight 

PB3/general-purpose 
input/output port 

Output Panel reset 

P66/general-purpose 
input/output port 

Output Touch controller reset 
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Table 5.4   Pins and Functions to be Used (RSK RX65N) 

Connected 

Device 

Pin Name Input/Output Description 

NHD-4.3-
480272EF-
ATXL#-CTP 

PB5/LCD_CLK-B Output Outputs the panel clock. 

PB4/LCD_TCON 0-B Output Outputs the synchronization signal (VSYNC). 

PB2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PB0/LCD_DATA 0-B Output Outputs the LCD signal R[3]. 

PA7/LCD_DATA 1-B Output Outputs the LCD signal R[4]. 

PA6/LCD_DATA 2-B Output Outputs the LCD signal R[5]. 

PA5/LCD_DATA 3-B Output Outputs the LCD signal R[6]. 

PA4/LCD_DATA 4-B Output Outputs the LCD signal R[7]. 

PA3/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

PA2/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

PA1/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

PA0/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PE7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PE6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PE5/LCD_DATA 11-B Output Outputs the LCD signal B[3]. 

PE4/LCD_DATA 12-B Output Outputs the LCD signal B[4]. 

PE3/LCD_DATA 13-B Output Outputs the LCD signal B[5]. 

PE2/LCD_DATA 14-B Output Outputs the LCD signal B[6]. 

PE1/LCD_DATA 15-B Output Outputs the LCD signal B[7]. 

P01/SSCL6 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

P00/SSDA6 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

PB7/general-purpose 
input/output port 

Output Backlight 

P97/general-purpose 
input/output port 

Output Panel reset 
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Table 5.5   Pins and Functions to be Used (Envision RX65N) 

Connected 

Device 

Pin Name Input/Output Description 

ER-TFT043-3 PB5/LCD_CLK-B Output Outputs the panel clock. 

PB4/LCD_TCON 0-B Output Outputs the synchronization signal 
(VSYNC). 

PB2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PB0/LCD_DATA 0-B Output Outputs the LCD signal B[3]. 

PA7/LCD_DATA 1-B Output Outputs the LCD signal B[4]. 

PA6/LCD_DATA 2-B Output Outputs the LCD signal B[5]. 

PA5/LCD_DATA 3-B Output Outputs the LCD signal B[6]. 

PA4/LCD_DATA 4-B Output Outputs the LCD signal B[7]. 

PA3/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

PA2/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

PA1/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

PA0/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PE7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PE6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PE5/LCD_DATA 11-B Output Outputs the LCD signal R[3]. 

PE4/LCD_DATA 12-B Output Outputs the LCD signal R[4]. 

PE3/LCD_DATA 13-B Output Outputs the LCD signal R[5]. 

PE2/LCD_DATA 14-B Output Outputs the LCD signal R[6]. 

PE1/LCD_DATA 15-B Output Outputs the LCD signal R[7]. 

P01/SSCL6 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

P00/SSDA6 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

P66/general-purpose 
input/output port 

Output Backlight 

P63/general-purpose 
input/output port 

Output Panel reset 

P07/general-purpose 
input/output port 

Output Touch controller reset 

 
  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 74 of 96 

Apr.15.25  

6. Using the Standalone Version of QE 

This chapter describes the usage of the standalone version of QE according to the actual flow of display 
adjustment. For details on the facilities of the standalone version of QE, refer to the help file which comes 
with the standalone version of QE. 

 

6.1 Starting the Standalone Version of QE 

Start the standalone version of QE by double-clicking on “¥QE-Display¥eclipse¥qe-display.exe” (Figure 6.1). 

 

 

Figure 6.1   Initial State of the Standalone Version of QE 

 

Note: In an environment where the WebView2 runtime is not installed in your PC, the workflow cannot be 

displayed. In this case, download and install WebView2 (x64 version) from the Microsoft web page. 

• Renesas Customer Hub FAQ 3000670: 

https://en-support.renesas.com/knowledgeBase/20814216 
 
  

https://en-support.renesas.com/knowledgeBase/20814216
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Select “1. Preparation” -> “Selecting a project” in the workflow of the standalone version of QE. Then select a 
project to open the “Display Tuning RX (QE)” view (Figure 6.2). 

Figure 6.2 is the display of a block diagram of the hardware of the GLCDC, showing the path for the output of 
image data and the relationships between the positions where images are to be corrected. Clicking on 
“Brightness” or “Contrast” for the adjustment of image quality produces the “Image Quality Adjustment” 
tabbed page, which allows various adjustments. 

 

Figure 6.2   “Display Tuning RX (QE)” View 
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6.2 Setting Data on the LCD Panel 

Information on the LCD panel which is connected to the user system is specified. When the display is 
connected to a system under development, you need to compare and adjust the specifications of the LCD 
panel and the display controller and find specifiable and appropriate settings. Information that has been 
specified is used in comparison. 

The LCD mounted on the RSK is an NHD-4.3-480272EF-ATXL#-CTP manufactured by Newhaven Display 
International. The LCD mounted on the Envision is an ER-TFT043-3 manufactured by EastRising 
Technology Co., Ltd. 

Selecting a project for which the board to be used has been specified in the “LCD Workflow (QE)” view 
displays information on the LCD panel. 

 

Figure 6.3   Selecting the LCD Panel 

 

When information on the LCD panel is set, the display type can be specified by selecting from among three 
patterns. The display type adopted is 3 (the method of using Vsync, Hsync, and DE signals) for the LCD 
panel mounted on the RSK and Envision. 

For details on setting information on the LCD panel, refer to chapter 7, Setting Detailed Data on the LCD 
Panel. 

 

6.3 Setting the Output of Control Signals 

Select the “TCON/LCD Setting” tabbed page in the “Display Tuning RX (QE)” view and specify the settings 
for the output of control signals (Figure 6.4). 

The following settings for the output of control signals are available on this page. 
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[Panel Driver Signal (TCON) Output Selection] 

Selection of output pins: 

Output to the LCD_TCON0 to LCD_TCON3 pins (TCON0 to TCON3) 

Active sense of control signals: 

Positive sense: [High Active] 

Negative sense: [Low Active] 

[LCD Setting] 

[LCD Output Format] 

24-bit RGB888 output: [24bit (GLCDC_OUT_FORMAT_24BITS_RGB888)] 

18-bit RGB666 output: [18bit (GLCDC_OUT_FORMAT_18BITS_RGB666)] 

16-bit RGB565 output: [16bit (GLCDC_OUT_FORMAT_16BITS_RGB565)] 

[Timing of Output Data] 

Output on rising edges of the panel clock: [Rising (GLCDC_SIGNAL_SYNC_EDGE_RISING)] 

Output on falling edge of the panel clock: [Falling (GLCDC_SIGNAL_SYNC_EDGE_FALLING)] 

[Background Color] 

0x00000000 to 0x00FFFFFF 

[Bit-endian of Output Data] 

Little Endian (GLCDC_ENDIAN_LITTLE) 

Big Endian (GLCDC_ENDIAN_BIG) 

[Pixel Order of Output Data] 

RGB (GLCDC_COLOR_ORDER_RGB) 

BGR (GLCDC_COLOR_ORDER_BGR) 

[LCD Backlight Control] 

Selection of control 

Selection of port number: 

PORT0 to PORTJ 

Selection of bit position: 

BIT0 to BIT7 

Active sense of control signals: 

Negative sense: [Low Active] 

Positive sense: [High Active] 

[LCD Reset Control] 

Selection of control 

Selection of port number: 

PORT0 to PORTJ 

Selection of bit position: 

BIT0 to BIT7 

Active sense of control signals: 

Negative sense: [Low Active] 

Positive sense: [High Active] 
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Figure 6.4   “TCON/LCD Setting” Tabbed Page 
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The following lists the settings that match the specifications of RSK and Envision boards. 

 

Table 6.1   Settings of TCON and the LCD Panel Used for the Application 

 RSK RX72N RSK RX65N Envision RX72N Envision RX65N 

Selection of output pins 

Vsync TCON0 TCON0 

Hsync TCON2 TCON2 

DE TCON3 TCON3 

Active sense of control signals 

Vsync Negative sense: [Low Active] Negative sense: [Low Active] 

Hsync Negative sense: [Low Active] Negative sense: [Low Active] 

DE Positive sense: [High Active] Positive sense: [High Active] 

[LCD Output 

Format] 

16-bit RGB565 output 

[16bit (GLCDC_OUT_FORMAT_16 

BITS_RGB565)] 

16-bit RGB565 output 

[16bit (GLCDC_OUT_FORMAT_16 

BITS_RGB565)] 

[Timing of Output 

Data] 

Output on rising edges of the panel clock 

[Rising (GLCDC_SIGNAL_SYNC_ 

EDGE_RISING)] 

Output on rising edges of the panel clock 

[Rising (GLCDC_SIGNAL_SYNC_ 

EDGE_RISING)] 

[Background 

Color] 

0x00000000 0x00000000 

[Bit-endian of 

Output Data] 

Little Endian (GLCDC_ENDIAN_LITTLE) Little Endian (GLCDC_ENDIAN_LITTLE) 

[Pixel Order of 

Output Data] 

BGR (GLCDC_COLOR_ORDER_BGR) RGB (GLCDC_COLOR_ORDER_RGB) 

[LCD Backlight Control] 

Selection of control Enabled Enabled 

[Port Number] PORT2 PORTB PORT6 PORT6 

[Bit Position] BIT7 BIT7 BIT7 BIT6 

Active sense of 

control signals 

Positive sense: [High Active] Positive sense: [High Active] 

[LCD Reset Control] 

Selection of control Enabled Enabled 

[Port Number] PORTK PORT9 PORTB PORT6 

[Bit Position] BIT4 BIT7 BIT3 BIT3 

Active sense of 

control signals 

Positive sense: [High Active] Positive sense: [High Active] 
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6.4 Setting the Graphics Layers 

Select the “Graphic Layer Setting” tabbed page in the “Display Tuning RX (QE)” view and specify the 
settings for the graphics. 

The following settings for graphics are available on this page. 

[Select Using Graphic Layer] 

Graphic layer 1 

Graphic layer 2 

Graphic layers 1 and 2 

[Graphic Layer 1 Setting] 

[Height of Image Data] 

16 to the value of VDP on the [Timing Adjustment] tabbed page 

[Width of Image Data] 

16 to the value of HDP on the [Timing Adjustment] tabbed page 

[Display Start Position (x-coordinate)] 

0 to the value of “VDP – 16” on the [Timing Adjustment] tabbed page 

[Display Start Position (y-coordinate)] 

0 to the value of “HDP – 16” on the [Timing Adjustment] tabbed page 

[Start Address of Frame Buffer] 

0x00000040 to 0xFFFFFFC0 

[Output Data Format] 

ARGB8888 (GLCDC_IN_FORMAT_32BITS_ARGB8888) 

RGB888 (GLCDC_IN_FORMAT_32BITS_RGB888) 

RGB565 (GLCDC_IN_FORMAT_16BITS_RGB565) 

ARGB1555 (GLCDC_IN_FORMAT_16BITS_ARGB1555) 

ARGB4444 (GLCDC_IN_FORMAT_16BITS_ARGB4444) 

CLUT8 (GLCDC_IN_FORMAT_CLUT8) 

CLUT4 (GLCDC_IN_FORMAT_CLUT4) 

CLUT1 (GLCDC_IN_FORMAT_CLUT1) 

[Graphic Layer 2 Setting] 

The same settings as those for [Graphic Layer 1 Setting] 

[Interrupts Setting] 

Selection of enabling VPOS detection 

Selection of enabling VPOS interrupts 

Selection of the use of a callback function 

[Callback Function Name] 

Desired character string 
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Figure 6.5   “Graphic Layer Setting” Tabbed Page 
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The following lists the settings that match the specifications of RSK and Envision board. 

 

Table 6.2   Settings of Graphics Layers Used for the Application 

 RSK RX72N Envision RX72N RSK RX65N Envision RX65N 

[Select Using 

Graphic Layer] 

Graphic layer 2 Graphic layer 2 Graphic layer 2 Graphic layer 2 

[Graphic Layer 1 Setting] 

All items Disabled Disabled Disabled Disabled 

[Graphic Layer 2 Setting] 

[Height of Image 

Data] 

272 272 272 272 

[Width of Image 

Data] 

480 480 480 480 

[Display Start 

Position (x-

coordinate)] 

0 0 0 0 

[Display Start 

Position (y-

coordinate)] 

0 0 0 0 

[Start Address of 

Frame Buffer] 

0x00800000 0x00800000 0x00800000 0x00800000 

[Output Data 

Format] 

RGB565 

(GLCDC_IN_FO

RMAT_16BITS_

RGB565) 

RGB565 

(GLCDC_IN_FO

RMAT_16BITS_

RGB565) 

RGB565 

(GLCDC_IN_FO

RMAT_16BITS_ 

RGB565) 

RGB565 

(GLCDC_IN_FO

RMAT_16BITS_

RGB565) 

[Interrupts Setting] 

[Enable VPOS 

Detection] 

Enabled Enabled Enabled Enabled 

[Enable VPOS 

Interrupt] 

Enabled Enabled Enabled Enabled 

[Use Callback 

Function] 

Used Used Used Used 

[Callback 

Function Name] 

_VSYNC_ISR _VSYNC_ISR _VSYNC_ISR _VSYNC_ISR 
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6.5 Adjusting the Timing of Control Signals for the LCD Panel 

Clicking on the “Start Display Adjustment” button after the debugger is connected opens the “Connection 
setting” dialog box. Generate the GLCDC parameter file and execute the program in which the sample code 
has been implemented. Selecting values for “Baud rate” and “COM port” and clicking on the “Start 
adjustment” button starts adjustment of the display. 

 

 

Figure 6.6   “Start Display Adjustment” Button 

 

 

Figure 6.7   “Connection setting” Dialog Box 
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During adjustment of the display, the message “Please tune the display. Do not restart or reset the program.” 
is displayed and the “Start Display Adjustment” button is replaced by the “Finish Display Adjustment” button. 
Changing the values shown in Figure 6.8 changes the timing of the control signals. This tool writes the 
changed values to registers of the GLCDC so that they will be reflected in the operation of the LCD panel on 
the board. 

 

 

 (Left button: Values on the display are set in the registers.  Right button: Changes to the register 

settings are made in real-time.) 

Figure 6.8  Adjusting the Timing of Control Signals 

 

Select the frequency of the panel clock from the combo box. The selected frequency is used to calculate the 
refresh rate, which is indicated at the bottom of the page, along with a value for any difference from the 
recommended value for the LCD panel. The value recommended for the LCD panel will have been specified 
as the initial value. 

Adjust the individual parameters in the spin boxes. The result of adjustment being shown in red numerals 
means that the value is out of the range of the specifications of the GLCDC or of the LCD panel. In such 
cases, adjust the value so that it is within the range of the specifications of the GLCDC and of the LCD panel. 
Check the range of values which are allowable in the specifications of the GLCDC by hovering the mouse 
over the value for adjustment that is being shown in red. 
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In an RSK, if a value being adjusted is restored to its default (the specifications of the LCD panel mounted on 
the RSK) with the “Restore the Displayed Settings to the Default” button, the recommended value for the 
horizontal front porch (HFP) of the LCD panel will be two, and this must be modified since it is out of the 
range of the specifications of the GLCDC. Modify the value to three or greater to satisfy the specifications of 
both the LCD panel and GLCDC. After that, the display of the adjusted value is changed from red to black. 

After you have determined the adjusted values, you can write the values from this tool to the registers of the 
GLCDC and check the results. 

 

 

 (Left button: Values on the display are set in the registers.  Right button: Changes to the register 

settings are made in real-time.) 

Figure 6.9  Buttons for Setting Registers 

 

The following two methods are used to set or make changes to values in the registers. 

 

Table 6.3   Facilities for Setting or Making Changes to Values in Registers 

Button Name Description 

 Set the Register The settings are written to the registers. This button is only effective 
during adjustment of the display. 

 

 

Set the Registers 
in Real-time when 
the Parameters 
are Changed 

When this button is active, changes are automatically written to 
registers every time the setting is changed. This button is not active 
by default. 

Writing to the registers only proceeds when the display is being 
adjusted; no operation proceeds if the display is not being adjusted. 

 

Note: Due to the display type and specifications of the LCD panel, fine changes to setting values (e.g. 

moving by several pixels) or changes to particular settings may not appear on the LCD panel. For 

example, the LCD panels mounted on the RSK and Envision are of display type 3, which does not 

allow the movement of positions in response to changes to the settings for the back porches and so 

on. 
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6.6 Reflecting the Output of Control Signals, Setting of Graphic Layers, and the 
Results of Timing Adjustment 

The output of control signals, setting of graphic layers, and the results of timing adjustment can be reflected 
in a program through the output of a header file. Clicking on the “Generating Header File” button of the 
standalone version of QE (Figure 6.10) generates a header file that reflects the specified items. 

 

 

Figure 6.10   “Generating Header File” Button 

 

When you select “For Display Settings” only and click on “Generate”, a header file is generated at the 
specified destination for output. The name of the header file and the output destination can be specified as 
desired. 

 

 

Figure 6.11   Selecting “For Display Settings” 

 

To reflect the timing of the project, output the header file with the name 'r_lcd_timing.h' in the following 
directory, and clean and build the project. 

 

Directory: 

<workspace folder>¥<project folder>¥src 
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6.7 Adjusting the Image Quality 

Clicking on the items for image quality adjustment enclosed by red frames in Figure 6.12 on the “Block 
Image” tabbed page makes the “Image Quality Adjustment” tabbed page appear, enabling the adjustment of 
image quality. 

 

 

Figure 6.12   Buttons for Selecting the Adjustment of Image Quality 

 

  



RX Family Guide to Using the Standalone Version of QE for Display [RX] with IAR EWRX 

R20AN0775EJ0100  Rev.1.00  Page 88 of 96 

Apr.15.25  

The “Image Quality Adjustment” tabbed page enables the adjustment of image quality. The standalone 
version of QE supports “Calibration Route Setting” and four facilities for adjusting image quality: “Brightness”, 
“Contrast”, “Gamma correction”, and “Dither process”. 

Changes to these settings will be reflected in real-time, allowing the adjustment of image quality with 
reference to the display on the LCD panel. 

Image quality is adjusted by using “Quick Setting” or “Custom”. If you select “Custom”, refer to the RX65N 
Group, RX651 Group User's Manual: Hardware (R01UH0590), RX72N Group User’s Manual: Hardware 
(R01UH0824) and the RX Family Graphic LCD Controller Module Using Firmware Integration Technology 
(R01AN3609), check the meanings of the settings made in each of the registers and the specifiable values, 
and adjust the image quality accordingly. 

 

 

Figure 6.13   “Image Quality Adjustment” Tabbed Page 
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6.8 Generating a Header File with the Results of Adjusting the Image Quality 

Click on the “Generating Header File” icon of the standalone version of QE to generate a header file that 
reflects the results of image quality adjustment which have been specified (see Figure 6.14). 

When you select “For Image Adjustment” only and click on “Generate”, a header file is generated at the 
specified destination for output. The name of the header file and the output destination can be specified as 
desired. 

 

 

Figure 6.14   Selecting “For Image Adjustment” 

 

To reflect the settings of image quality adjustment in the project, output the header file with the name 
'r_image_config_.h' in the following directory, and clean and build the project. 

Directory: 

<workspace folder>¥<project folder>¥src 
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7. Setting Detailed Data on the LCD Panel 

If you select “Custom” from the “Maker/Type” pull-down list in the upper section of the dialog box shown in 
Figure 6.2, the “Edit Custom Display Data” dialog box (Figure 7.1) appears. Enter information on the LCD 
panel in this dialog box. 

 

 

Figure 7.1   “Edit Custom Display Data” Dialog Box 

 

7.1 Entering Names for Registration 

Enter the desired names in “Maker/Type” and “Model Name/Size” in the “Edit Custom Display Data” dialog 
box (Figure 7.2). These names will be registered in the drop-down list for selection. 

 

 

Figure 7.2   Registering a Name 
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7.2 Selecting the Display Type 

Table 7.1, Main Control Signals, lists the control signals required for connecting an LCD panel. The 
standalone version of QE supports devices which have three display types with a combination of those 
control signals. 

 

Table 7.1   Main Control Signals 

Name Outline of Facility 

Horizontal 

synchronization signal 

(Hsync) 

The signal that generates the timing for one line to be displayed 

Vertical synchronization 

signal (Vsync) 

The signal that generates the timing for one screen to be displayed 

Panel clock (CLK) The signal that drives the sampling of pixels to be displayed 

Display enable (DE) The signal indicating that valid data are being output 

Data (Data) Data to be displayed 

 
The user must check which control signals are required in the specifications of the LCD panel in use and 
select the appropriate one from among the three display types shown in Table 7.2, Display Types and 
Control Signals to be Used. 

 

Table 7.2   Display Types and Control Signals to be Used 

Name Display type 1 

 

Display type 2 

 

Display type 3 

 
Horizontal 

synchronization signal 

(Hsync) 

Used Unused Used 

Vertical synchronization 

signal (Vsync) 

Used Unused Used 

Panel clock (CLK) Used Used Used 

Display enable (DE) Unused Used Used 

Data (Data) Used Used Used 
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7.3 Entering the Control Timing 

Enter the control timing with reference to the datasheet for the LCD panel. Values entered under Typ. are 
used as the initial values for timing control. Values entered under Min. and Max. are used to check whether 
or not the timing as adjusted by using the standalone version of QE GUI is within the range. 

Figure 7.3 shows the result of data input for the LCD panel mounted on the RSK. Enter values with reference 
to Table 7.3, Excerpt from the Datasheet for the LCD Panel on the RSK. 

 

 

Figure 7.3   Result of Control Timing Input 
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Table 7.3   Excerpt from the Datasheet for the LCD Panel on the RSK 

Parameter Symbol 
Spec. 

Unit 
Min. Typ. Max. 

Clock cycle fclk - 9 15 MHz 

Hsync cycle 1/th - 17.14 - KHz 

Vsync cycle 1/th - 59.94 - Hz 

Horizontal Signal 

Horizontal cycle th 525 525 605 CLK 

Horizontal display period thd 480 480 480 CLK 

Horizontal front porch thf 2 2 82 CLK 

Horizontal pulse width thp 2 41 41 CLK 

Horizontal back porch thb 2 2 41 CLK 

Vertical Signal 

Vertical cycle tv 285 286 399 H 

Vertical display period tvd 272 272 272 H 

Vertical front porch tvf 1 2 227 H 

Vertical pulse width tvp 1 10 11 H 

Vertical back porch rvb 1 2 11 H 

 

7.4 Editing the Created Display Data 

When the “Edit and Delete the Custom Display...” menu item is executed after clicking on the menu button 
on the toolbar, the created display data can be re-edited. 

 

 

Figure 7.4   “Edit and Delete the Custom Display...” Menu Item 
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8. Details of Settings 

This chapter gives supplementary explanations and notes for each of the procedures described in section 
1.1, Flow of System Development with the Standalone Version of QE. 

 

8.1 Setting the GLCDC FIT Module Not Supported by the Standalone Version of QE 

The Smart Configurator can be used to change the settings of the GLCDC FIT module which are not 
supported by the standalone version of QE. However, changing the settings from the default values may lead 
to an error. Confirm the specifications of the GLCDC FIT module. 

For the specifications of the GLCDC FIT module, refer to the RX Family Graphic LCD Controller Module 
Using Firmware Integration Technology Application Note. 

 

8.2 From Execution to the End of Adjustment 

After the program has been created, start the debugger and execute the program. If the initial screen is not 
correctly displayed, the settings are not correct. Check the values adjusted by the standalone version of QE 
and the settings of parameters of the GLCDC FIT module. 

Figure 8.1 shows the flow of troubleshooting. 

 

The adjustment screen is not 

correctly displayed.

QE returned an error (a return 

value of the R_GLCDC_Open 

function).

A parameter of the 

GLCDC that is not 

supported by QE may be 

incorrect. Check the 

settings and modify any 

incorrect parameters.

The image is displayed with 

different colors from those on 

the adjustment screen.

Nothing is shown on the screen 

(the LCD panel is not lit 

anywhere).

Yes

Check that there are no 

omissions or errors in control of 

the user board in terms of the 

pin settings from the Smart 

Configurator, the reset, the 

backlight, and so on.

e.g. Port numbers, output 

values, etc.

No

The red frame is not 

displayed.

Adjustment of the timing may 

not have been correct. Check 

the settings on the "Timing 

Adjustment" and "TCON/LCD 

Setting" tabbed pages of the 

"Display Tuning RX (QE)" 

view.

The image does not fit in the 

LCD panel.

The displayed image is 

completely different from the 

adjustment screen.

The settings for TCON and data 

pins may be incorrect.

Check the settings in terms of 

pin settings from the Smart 

Configurator or on the "TCON/

LCD Setting" tabbed page of the 

"Display Tuning RX (QE)" view.

Yes

(other than 

GLCDC_SUCCESS)

No

(GLCDC_SUCCESS)

 

Figure 8.1   Troubleshooting 
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8.3 Setting the Maximum Memory Size for Use with the GUI 

If a created GUI contains many widgets, the GUI may not work properly when they are displayed on the 
screen with the memory settings at the time. In this case, increase the value of “Maximum memory size used 
in GUI” in the “emWin setting” dialog box. The default setting is 80 KB (1024 * 80 = 81920). Set a value, such 
as 100 KB, that is suitable for the GUI you have created. 

 

Figure 8.2   “emWin setting” Dialog Box 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
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characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
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injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 

safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 

aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
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10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
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transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 
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